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Newworld

Toolbox code removed from ROM

Some booting code removed from ROM

* Supported by iMac and new Blue&White
ROM

°

ROM file in System Folder T EDOST
ROM in RAM ~ Open Firmware

~ More speed
- 3 MB less user memory

&

Mac OS ROM image

— 1 Notes

Newworld
NewWorld is a project to reduce the size of the 4MB Mac ROM by removing the Tool Box code contained
in that ROM.

Open Firmware version 3 is a part of that project. When the Tool Box was removed from the 4MB ROM, a
portion of the booting logic was also removed. Open Firmware version 3 also provides for booting using
FCode drivers. Version 3 first appeared on the iMac and is being used on all future platforms.

Features of the New Approach
Because the new hardware features are ditferent from older Macintosh computers, new software features
are needed in addition to the NewWorld requirements for other Macintosh computers.
*Power-on Self Test (POST) software, which resides in the Boot ROM, provides hardware initialization and
diagnostic functions.
*Open Firmware, which resides in ROM, completes hardware initialization, provides a description of the
hardware, loads initial OS software, and transfers control to that software.

*Run-Time Abstraction Services (RTAS), which resides in ROM, is instantiated into RAM through an Open
Firmware method called by the OS. RTAS provides functions that are available to the OS at any time to
access platform-specific hardware, such as the real-time clock and NV-RAM.

*Mac OS ROM image, a file that contains the ToolBox ROM code and other high-level software that resides
in the ToolBox ROM on other Macintosh computers.

*10Base-T/100Base-TX Ethernet device driver, in the Boot ROM.
*Device driver for the USB hub, Apple USB keyboard, and Apple USB mouse, in the Mac OS ROM image.

In addition to the above new features, changes have been made to the source base for the components of the
Mac OS ROM to abstract it from the hardware. These changes are designed to reduce bring-up time and
effort, improve reliability of the Mac OS ROM components, and reduce testing time, by moving the changes
necessary for a new computer to the Boot ROM. Some of the hardware components accessed through this
new abstracted software are the interrupt controller, ADB, USB, SCSI, ATA (IDE), sound, and Ethernet.
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The NewWorld architecture has a ToolBox ROM image that is high-level enough to be used on many
different Macintosh computers. Although the iMac is the first Macintosh computer to use it, this new
architecture is intended for use on all future Macintosh computers.

Performance

Performance of an iMac computer using ROM in RAM should exceed performance measurements for other
Macintosh computers with comparable CPUs and speeds due to improved interrupt handling with the New
World approach. In addition, performance is improved due to executing code that normally exists in ROM
in RAM, because the RAM devices operate faster than the ROM devices normally used.

RAM Footprint

The iMac is the first Macintosh computer to have its Toolbox ROM image stored in RAM. This removes
approximately 3 megabytes of RAM from Mac OS usage. In effect, a system with 32 megabytes of RAM
appears to have only 29 megabytes available. Some portion of the missing 3 megabytes is offset by having
fewer patches in RAM. Other mechanisms are being explored in an attempt to minimize the impact of
ROM-in-RAM.

User Experience
Setting the boot volume from the Startup Disk control panel makes all the changes to the boot process that
are necessary to operate with a ToolBox image in RAM. The control panel user interface remains
unchanged for this release.

Data Structures and Files

The ToolBox ROM image is contained in a new file, named "Mac OS ROM", that is kept in the System
Folder. The ToolBox ROM image is exactly the same as it would be if it were an actual ToolBox ROM,
containing the ToolBox software, the kernel software, and the 68K emulator.

The Startup Disk control panel sets the Open Firmware's boot-device configuration variable by modifying
the Open Firmware NV-RAM partition that contains the Open Firmware's configuration variables. The
format of the NV-RAM partition is defined in the Open Firmware CHRP Binding. The partition is accessed
using RTAS.

Compatibility
A Mac OS ToolBox image that is in write-protected RAM will appear to be a ROM to all MacOS software

and applications. Because the image of the ToolBox in RAM appears to be a ROM, the ROM-in-RAM
approach is completely compatible with all application and system software.

The Mac OS ToolBox image is kept in a file in the System Folder on the specified boot device. In order to
avoid problems with internationalizing the name, the file is located by file type instead of by name.

In order for Open Firmware to retrieve the ToolBox image file, it must be able to read the selected boot
device. If the ToolBox image file is on a partition that is on a RAID, encrypted, striped, or otherwise non-
standard device, Open Firmware must be able to read from these devices in order to boot Mac OS. Two
possible solutions to this problem are to have a standard partition available on the device that contains the
ToolBox image file, or to provide Open Firmware methods to read the file.

The main incompatibility that ROM-in-RAM approach introduces is that memory is not mapped one-to-one,
as it has been for previous PCl-based Macs. Software that assumes the logical and physical addresses are
the same will fail, even when Virtual Memory is not on.
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MacOS 8.5 and 8.5.1 New features

* Requirements

o New Features

&

About Mac OS 8.5

Mac OS 8.5 is the latest reference release of Mac OS system software. It is designed for use with Apple
PowerPC Macintosh computers only and offers many new features, enhancements, and updated
components. This training is designed to allow you to become proficient with these new features and
understand key information regarding common issues and their workaround solutions.

The term "reference release” means that the software is distributed as a stand-alone system software
package that can be installed regardless of the version of Mac OS currently installed.
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MacOS 8.5 Requirements

¢ Mac OS-based Apple computer with a PowerPC

processor

* 50 MB to 250 MB of free disk space

* 16MB of physical RAM, with virtual memory (VM) set
to at least 24 MB

&

System Requirements
In order to install and run Mac OS 8.5, you will need the following system configuration:
*Mac OS-based Apple computer with a PowerPC processor (PowerPC upgrade cards and 680X0 processors
are NOT supported)
150 MB to 250 MB of free disk space
*16MB of physical RAM, with virtual memory (VM) set to at least 24 MB

The minimum amount of RAM will let the computer perform only at minimum performance. Installing
additional RAM will increase the system performance.

With VM turned off there may be up to a 10 MB difference in RAM usage. This difference is normal and
due to the decreased RAM requirements of the system software when VM is on (due to code-mapping).
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New features

* Application Switcher

* Appearance Manager 1.1
* Apple System Profiler 2.1.1
 AppleScript 1.3

e ColorSync 2.5.1

* Date & Time 8.1

* Disk First Aid 8.5.1

e Drive Setup 1.6

* Energy Saver 2.1

* File Exchange 3.0

e
o

&

Sherlock (Find)

Finder 8.5

Internet Control Panel 1.0
Mac OS Help

Mac OS Install

Multilingual Internet Access
Navigation Services 1.1
Network Browser 1.0
PlainTalk 1.5.3

Unicode Support

ACSE Update 1999/Mac OS

Enhancements

Mac OS 8.5 provides the following new features and performance and reliability enhancements over and
above the features delivered with previous system releases.
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Application Switcher

* tear-off Application menu

* Allows for easy switching and hiding of applications.
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Application Switcher

The Application Menu in the Finder now can be viewed in a number of different formats. The name of the
active application now appears next to its icon in the menu making it easy to determine which application is
currently active. In addition, the application menu can be "torn off" and appear on the desktop as a floating
window displaying all applications running on the system.

The Application Switcher window can be used to select or activate any program running on the system by
simply clicking its name or icon in the Application Switcher window. You can also use the keyboard
shortcut Command-Tab to switch between programs or use Command-Shift-Tab to switch between
programs in reverse order. To change the keys used for this shortcut, see the link "Help me modify the
keyboard shortcuts” in the Switching between open programs section in Mac OS Help.

Options

Options for the Application Switcher can be accessed by using the keyboard and mouse, and many
functions can be scripted using AppleScript:

Hide Application

To hide an application, hold down the Option Key while clicking on a different application in the
window,

Collapse the window

Click the collapse icon in the upper right corner of the window. (NOTE: This feature is only
available while displaying in vertical orientation.)

Resize the Application Switcher window

To resize the window, move the mouse pointer to the edge of the right side of the window until the
cursor changes, then click and drag the window to the desired size.

Open document

To open a document, drag the document to the compatible application name in the Application
Switcher window.
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Hide/Show application name

To hide and show the application names, click the zoom box:

Toggle between small and large icons

Hold down the Option Key while clicking the zoom box:

Toggle between vertical and horizontal orientation

Hold the Option and Shift keys down together while clicking the zoom box.

NOTE:
Some features of the Application Switcher are only available via AppleScript. See Mac OS Help for more
details on using AppleScripts with Application Switcher.

April 1999 © Learning Associates International, www.lai.nl

4-9



——— Notes

ACSE Update 1999/Mac OS

Appearance Manager 1.1

* Customizable themes

* Alternate appearances
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Appearance Manager 1.1

The Appearance control panel has been updated to provide additional features and controls for Appearance
Manager 1.1. Each feature is accessible through one of six tabs in the Appearance window: Themes,
Appearance, Fonts, Desktop, Sound, and Options.

Themes
The Themes tab provides the ability to configure the desktop appearance as a group of settings called a
Theme. Selecting a theme will automatically adjust your system font, appearance, sound, desktop pictures
and patterns, and options to the specified settings. You can use the predefined Themes included with Mac
OS 8.5, or create a custom Theme. To create a custom Theme, after selecting your appearance settings,
click the Save Theme button. A window appears allowing you to name the Theme.
After saving the Theme, click on your Theme in the Themes section of the Appearance control panel to use

its Appearance settings.

Appearance
This tab provides for the overall look of menus, icons, windows, and controls. Use the Appearance pop-up
menu to select an Appearance type. Mac OS 8.5 includes the "Apple platinum" appearance. In the future,
other appearances from Apple and other companies can be added by dropping its Appearance file onto the

System Folder.

Desktop
The Desktop tab allows you to select a pattern or picture to be displayed on the Finder desktop.

Sound

The Sound tab allows you to select a set of sound effects to be used when actions take place

Options

The Options tab allows you to specify settings for scroll arrows, scroll boxes, and window collapse.
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Apple System Profiler 2.1.1

* Reports more comprehensive hardware and software
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Apple System Profiler 2.1.1

The Apple System Profiler is a software application that gathers and displays information about the
Macintosh computer on which it is run. This information includes data such as system software version,
memory installed, types and number of hard disk volumes attached, and informatior on installed control
panels, extensions, and applications. The goal of Apple System Profiler is to provide all who use, service
and support Power Macintosh systems with an easily understood, consistently available, extensible, scalable
and accurate profile of the computer they are working with.

Apple System Profiler version 2.1 provides many new features and enhancements over previous versions.
Some of the overall goals for version 2.1 are to add features that have been requested, to support new Power
Macintosh models, and to match the Mac OS 8 appearance "look and feel” more closely.

Tips for troubleshooting

Most of the information that ASP gathers is available via other means. However, having a single place to
look for information is easier than digging through multiple control panels. Also, it provides a “safe” place
to get this information without the possibility of inadvertently changing settings. Clearly, ASP does not
replace control panels (such as the Extensions Manager) because it only “reports settings” and never
“changes settings."

Installed Memory

Apple System Profiler not only reports the amount RAM installed, but also provides details on the type of
memory and its location on the computer's logic board. This information can be useful in situations where
the amount of memory installed is in question or there is difficulty in determining the size or type of an
installed memory module. In addition, the location of memory on the logic board can help determine if the
proper configuration has been made to support features such as memory interleaving.
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Devices Properly Attached and Recognized

Apple System Profiler's Devices and Volumes section is an excellent tool for determine what is installed in
the computer and whether a device is properly recognized. In addition, the graphical layout of this section
diagrams the order and location where devices are connected. For example, SCSI hard drives and
peripherals are displayed with ID and bus numbers making it easy to locate device ID numbers and
determine whether internal or external bus connection was used. Volumes are displayed to the right of the
hard disks indicating the number of volumes or partitions each drive represents. You can check if NuBus
and PCI Interface cards to see if they are recognized as installed in their proper slots.

Reporting
Apple System Profiler allows you to generate a system configuration report file that you can forward to
others as an aid for system troubleshooting. This feature can save you time in determining the configuration
of a computer and help you diagnose problems with misconfiguration and conflicting software.

Apple vs. third-party extensions

Similar to the Extensions Manager control panel, Apple System Profile displays a list of installed control
panels and extensions and their versions. To assist with diagnosing software issues, you can use Apple
System Profiler to determine if older versions of software are installed and whether third-party software has

been installed.

Multiple system folders

Issues involving system crashes and Startup problems can sometimes be traced to having multiple system
folders on the same volume. Apple System Profiler displays the location and version of all installed active
and previous system folders. This allows you to quickly determine if the correct version is installed and
locate and remove any extra folders.

Known issues and workarounds

ASP's reports "TEXT" section has a 32K limit, which you'll reach with about 400 files. ASP currently
displays an alert telling you when you have reached the limit and stops writing text to the report. You can,
however, drag a large file view into another program or onto the desktop.
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AppleScript 1.3

* improved performance

* more scriptable tasks and control panels

» folder action scripts for automated tasks [

S

AppleScript 1.3
Native PowerPC code

AppleScript has been completely rewritten in native PowerPC code. As a result, scripts can now run as
much as five times faster (depending on the task being scripted).
Dictionaries
The dictionaries for the Finder, many other system software components, and the Mac OS scripting
additions (Standard Additions file) have been consolidated, cleaned up and organized. Items have been
organized by functional groups, making it easier to understand a component's scriptable functionality.
Scripts folder

The new Scripts folder inside the System Folder provides a central, stable location for your scripts.
AppleScripts dropped onto the System Folder are automatically placed in this folder:

The Folder Action Scripts folder inside the Scripts folder contains the folder actions scripts included with
the Mac OS.
New scriptable system software components
The following system software components are now scriptable:
Control panels
Appearance
Apple Menu Options
File Exchange
Location Manager
Extensions
Application Switcher

ColorSync Extension

April 1999 © Learning Associates International, www.lai.nl



Applications
Apple Help Viewer (see Install & Use, Part 6 - Apple Help)
Apple System Profiler
Desktop Printer Manager
Disk First Aid
Sherlock (Find)
New scripting additions and features

Most Apple-supplied scripting additions (file type "osax") are now unified into one file, the Standard
Additions file. Scripting additions expand the capabilities of AppleScript, providing additional commands

that you can use in your scripts.

Folder Actions

Folder actions allow you to run AppleScripts when you interact with a folder in any of the following ways:

*Open a folder

*Close a folder

*Add items to an open folder

*Remove items from an open folder

*Move or resize a folder window

By using folder actions, you can make tasks you do frequently take place automatically. For example, you
can specify that when a file is placed in a folder, it's always copied into another folder as well. If a folder
has folder actions attached to it, the folder's icon displays a small script icon badge:

To assign a folder action to a folder, press and hold the control key while clicking on the folder. Select
Attach a Folder Script from the contextual menu that appears.
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ColorSync 2.6

* Expanded AppleScript dictionary

* JPEG and GIF support

* Control Panel interface

* Intelligent profile listing in Monitors & Sound
¢ Gray space profile

e Expanded bitmap support

* Additional API calls for developers

——— Notes

ColorSync 2.6

ColorSync is a Color management system that ensures the colors you see on your monitor closely match the
colors you print or scan. In Mac OS 8.5, you use the Monitor Calibration Assistant in the Monitors & Sound
control panel to adjust your system for accurate Color reproduction.

Expanded AppleScript dictionary

The ability to use AppleScript to automate ColorSync was introduced in ColorSync 2.5 by making the
ColorSync Extension a faceless background application, allowing it to respond to Apple events. ColorSync
2.6 responds to even more commands than it did before, allowing the user to get detailed information about
profiles in the ColorSync Profiles folder, profiles associated with displays, and profiles embedded within
images. Most of these attributes of profiles can also be changed by the user via AppleScript. Images can be
matched, proofed, or embedded with profiles as before, and can also have any embedded profiles removed
by unembedding. See the Sample Scripts Read Me in the ColorSync Extras:AppleScript Files folder for
detailed information about writing AppleScripts for ColorSync.

JPEG and GIF support

Prior to ColorSync 2.6 only TIFF images could be used with the ColorSync Photoshop Plug-ins and with
AppleScripts performing ColorSync operations. Now both Applescripts and the plug-ins will work with
images saved in the widely used JPEG and GIF formats. This opens up a whole world of web based
ColorSync workflows for the designer and allows users to easily embed and match images for use in their
own web pages, bringing ColorSync directly to the web. Web browsers can correctly render images with
embedded or associated profiles on the user's display, calling ColorSync to match from the image's profile
to the user's display profile, ensuring that web based images get rendered the way they were intended to be
seen.

New Control Panel design

The control panel has been redesigned for clarity, subdividing the various popups which control ColorSync's
behavior. Controls and preferences can be set in the Profiles and CMMs panels, and further information
about ColorSync and related technologies can be found by selecting the live web links found in the About
panel.
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Under the Profiles tab, the System Profile represents your monitor, or your main monitor if you have more
than one. This setting is used by ColorSync-aware applications to color match images so they look best on
your particular display. Although it's possible to change your System Profile using this popup, it's better to
do so by selecting a profile from the ColorSync Profile panel under the Color section of the Monitors &
Sound control panel. Choosing a profile from Monitors & Sound will set your system profile and correctly
update your display's gamma and white point settings, whereas choosing a profile from the popup in the
ColorSync control panel sets your system profile but doesn't update your display's gamma. See the Monitor
Calibration section below for more details.

The RGB Default and CMYK Default settings are meant to represent the color space of images which have
no embedded profile or whose original profile is unknown. If a ColorSync aware application encounters an
RGB image of unknown origin, the application can use the setting of the RGB Default popup as a stand in
to represent the image's source color space when performing color matching operations. The CMYK
Default behaves similarly, defining a profile to be used to represent the destination space of RGB images
being matched to CMYK, or to represent a standard CMYK space. CMYK profiles are a bit trickier than
RGB profiles, in that more variation exists between different CMYK devices than between different RGB
devices, in general. If you have a CMYK printer, or know you will be using a certain CMYK printer
elsewhere, you should set the CMYK Default to that preferred printer.

The second tab in the control panel is labeled CMMs. A CMM is a Color Matching Method (or Color
Matching Module, depending on who you ask), a plug-in of sorts which contains low level color matching
code. ColorSync is an architecture of tools, routines, and interfaces which unify and integrate color
matching at a system-wide level, whereas CMM:s are individual color matching engines. Both are necessary
and work together to perform color matching. Apple ships the Heidelberg CMM bundled into the ColorSync
Extension itself so that at least one CMM is always present. The Kodak CMM or the Agfa CMM can
additionally be installed and called upon to do color matching by doing a custom install with the ColorSync
2.6 Installer instead of the default easy install.

The setting Preferred CMM is the system level setting that determines which CMM should be used when
matching with a given profile. Most profiles contain information specifying which CMM the profile author
intended the profile to be used with. When Preferred CMM is set to Automatic, ColorSync will use the
CMM specified in the profile itself. Below the option for Automatic follows a list of all installed CMMs. If
any of these specific CMMs is chosen for Preferred CMM, ColorSync will always use that specific CMM
regardless of what is specified in the profile. Most users should probably set the Preferred CMM to
Automatic for best results.

Intelligent profile listing in Monitors & Sound

Launching the Monitors & Sound control panel and selecting the Color button brings up the ColorSync
Profile panel, and selecting a profile from this list associates that profile with your display. Earlier versions
of ColorSync populated this list with all display profiles installed in the ColorSync Profiles folder.
ColorSync 2.6 improves this listing by removing from the list any profiles which would not logically apply
to your display based on your current resolution and screen depth settings. For instance, if your display is
set to a resolution of 1024 by 768, any profile of a device not capable of that resolution will be removed
from the list, narrowing down your list of possible display profiles from which to choose.

New Gray Space Profile

ColorSync 2.5 shipped with the standard color space profiles Generic RGB Profile, Generic CMYK Profile,
Generic Lab Profile, and Generic XYZ Profile. ColorSync 2.6 adds to this set the Generic Gray Profile.
Users can now create grayscale images from color images by matching to the Generic Gray Profile using
either AppleScript, the PhotoShop plugins, or ColorSync aware applications.

Expanded Bitmap Support

Of interest to developers is the addition of more types of bitmap formats supported natively by ColorSync.
Some of these new formats allow ColorSync to support both big-endian and little-endian (Mac and PC)
bitmap formats for enhanced cross platform functionality, while others allow higher precision in dealing

with color data.
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Date & Time 8.1
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Date & Time 8.1

The Date & Time 8.1 control panel now provides an option for automatic daylight-saving time switching as
well as the ability to use a network time server to synchronize the Macintosh clock.

You must have an active TCP/IP connection to the Internet to in order to connect to a network time server.

Attention

If the date is set to 1963 or earlier, the computer will hang if you try to manually sync with the network time
server via the Date & Time control panel. To resolve the immediate situation, you can force quit the Time
Synchronizer and then force quit the Date & Time control panel. To force quit an application, press the
command-option-esc keys simultaneously. Then set the date manually in the Date & Time control panel.

This situation may arise on PowerBook computers after they have been without power for several days. The
backup battery will drain and the clock will reset to 1/1/1904. If this happens, make sure you reset the date

before using the network time server.
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Disk First Aid 8.5.1

You can now test and repair your Startup disk or volume using Disk First Aid 8.5.1 without first starting up
from a different volume. In addition, Disk First Aid 8.5.1 provides the following enhancements:

Automatically tests and repairs the startup volume on startup after an improper shutdown or crash occurs.

Verifies and repairs many kinds of damage caused by use of older disk utilities that are not compatible with
Mac OS Extended (HFS Plus) volumes.

Supports AppleScript for verifying and/or repairing a volume.

Function

Disk First Aid ensures the integrity of individual files on a volume cataloged by Mac OS Standard format
(known as HFS) and Mac OS Extended format (known as HFS+). (HFS & HFS+ - are methods for placing
data on a hard drive used by the Mac OS).

A disk can contain several partitions, which are treated as separate virtual disks by the system. Each
partition contains information similar to that shown:
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Catalog File

Partition Map
The first physical block (512K) contains the disk's "Partition Map". This specifies the first and last physical
blocks of each partition as well as its type (Macintosh, A/UX, MS-DOS, etc.). It also contains the value for
the size of "Logical Blocks. Physical blocks are always 512K. The logical block size will vary depending
upon the capacity of the drive. Whenever a file is written to the disk, it is allocated a certain number of
logical blocks or clumps. This slows down the process of fragmentation, but can result in open space being
left at the end of the file allocation.

Device Driver
After the partition map is the device driver used for SCSI communications with that device. (Note that if the
device driver is updated after the drive is initialized, HFS may move the driver to the end, depending on
space constraints).

Boot Blocks

The HFS volume begins with two boot blocks. This is where booting instructions are stored along with
directions for locating the system and Finder files.

Master Directory Block
Contains volume information such as the date and time of volume's creation and number of files the volume
contains. When the MDB is read, the volume is mounted and an area is created in memory called the
Volume Control Block (VCB).

Volume Bitmap
A record of which logical blocks in the volume are allocated to files. It contains one bit for each allocation
block on the volume. If the block is taken then the bit is set. Otherwise, the bit is clear if the block is
available.

Catalog File/Tree
Contains hierarchical information about the relationship and structure of files and folders and their location
on a volume.
Specifically, it contains the parent directory for each file. In order to determine the full path, a directory's
parent is found, and so on, until the root level is reached. The Catalog File and Extents File are each in the
form of a "B-Tree" (and are the source for all B-Tree type errors). See below for a discussion of B-Trees.

Extents File/Tree

An "Extent” i1s a contiguous range of logical blocks that are allocated to a file. The Extents File (also called
"Extents Overflow File") keeps track of the location of records that can't be placed contiguously. This
information is used to locate pieces of a file when it's loaded. Some Extent information is contained within
the MDB and VCB. The first three file extents are always retained in memory with the VCB.

Given the above information it is understandable why optimizing, or "defragmenting" a disk is so effective.
Not only does making files contiguous reduce seek time, but continual accesses to the Extents File are
eliminated all of the needed information is already in memory.
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Drive Setup 1.6
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* provides an alert when updating an older driver over a
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Select a drive and then a function.

—— Notes

Drive Setup 1.6

The Drive Setup utility provides drive initialization, driver update, and testing services for Apple hard
drives. Drive Setup 1.6 provides the following enhancements:

*Drive Setup can now reinitialize a drive maintaining the former partition scheme and formats.

*Warmns the user before updating a newer driver with an older driver.
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Energy Saver 2.1

Consolidates the functionality of the control panels

- PowerBook
- PowerBook Setup
- AutoRemounter

Control Strip module for
quick access to settings
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Notes

Energy Saver 2.1

The Energy Saver 2.1 control panel now consolidates the functionality of the PowerBook, PowerBook

Setup, and Auto Remounter control panels into the Energy Saver control panel.

The Energy Saver settings window opens with a different interface depending if you are using a desktop
computer or a PowerBook computer.

NOTE

Energy Saver is not compatible with or installed on NuBus-based Power Macintosh computers, such as the
Power Mac 5200, 5300, 6100, 6200, 6300, 7100, or 8100.Contextual help is available by clicking the .
Balloon Help is available for this window.

The Reduce processor speed option is available for PowerBook G3 computers only.

The Energy Saver control strip module (PowerBook computers only) allows you to switch quickly between
better conservation and performance settings, put the PowerBook into sleep mode, and open the Energy

Saver control panel.
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—— Notes

File Exchange 3.0

The new File Exchange 3.0 control panel unites Mac OS Easy Open and PC Exchange capabilities into a
single control panel. The control panel is divided into two sections: PC Exchange and File Translation. To
access each section, click its tab in the File Exchange control panel.

PC Exchange
The PC Exchange tab provides settings for opening files from PC DOS disks with Macintosh applications.
Map PC Extension to Mac OS file types on PC disks

Check this option to automatically map PC files to Mac OS file types based on its PC extension. If this
option is not selected, PC files will be treated as generic text files.

Open unmapped files on any disk using mappings below

Check this option to open unmapped files on any disk with the file mappings listed in the window. (NOTE:
QuickTime Exchange, located in the QuickTime Settings, will map media files before this option takes
effect.)

PC SCSI Disks

Check this option to automatically mount a PC SCSI disk when you startup the computer. If this option is
disabled, you can click the Mount Now button to mount the PC SCSI disk after startup.

The PC Exchange section for File Exchange 3.0 cannot be used to identify SCSI ID numbers or drive
ROM's and firmware revisions, as was available in previous versions of PC Exchange. This information is
now available in Apple System Profiler 2.1.1.
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File Translation
The File Translation section of File Exchange allows you to specify settings for translating files from one
file type to another.
NOTE: Previous versions of Mac OS included MacLinkPlus translation software from DataViz. This
software provided software translation capabilities similar to File Exchange and is not included with Mac
08:8.5.
Translate documents automatically
Check this option to enable automatic translation of documents when opened from the Finder or from dialog
boxes.
Always show choices when translating files
Check this option to show the available choices when translating files instead of using the default
translations.
Don't show choices if there's only one
Check this option to automatically choose a file translation application when there is only one choice.
Include applications on servers in translation choices

Check this option to search connected server volumes for application choices. NOTE: selecting this option

Translation Preferences
The file type and application to be translated to is shown in this window. To add a translation preference,
click the Add button.
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Sherlock (Find)
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— Notes

Sherlock (Find)

The Find File application, previously located in the Apple menu, has been expanded and renamed S herlock
in Mac OS 8.5. It includes two additional features: Find By Content and Search Internet. In addition,
Sherlock allows you to save search settings into a settings file which can be used to quickly perform
searches.

Find File

The Find File section lets you search local disks and connected file server volumes for files by file name or
by many other file attributes.

Find By Content

The Find by Content section of Sherlock lets you search the contents of files on your local volumes for one
or more key words. Find By Content works by searching for key words contained within the text of each of
the files. After indexing your files, you can search for information contained within the file without first
having to open the file. This makes finding information contained within multiple files quick and easy.

Find by Content and Search Internet requires QuickTime 3 software installed.

You must index your hard disk volumes before you can search the contents of the files. Server volumes
cannot be indexed. The Find button will remain disabled (gray) until indexing has been completed.

Depending on the number of files contained on the volume, indexing may take a significant amount of time
to complete. Note that, for optimum performance and disk space usage, only the first 2000 unique terms of
each document are indexed.

To summarize the contents of a file to the clipboard, hold down the Control key while clicking on the file
name in the search results list. Select Summarize to Clipboard from the contextual menu that appears. The
contents of the file will be summarized and displayed in the Finder's clipboard window:

NOTE: The Summarize to Clipboard feature works only on files whose type is TEXT.
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Search Internet

The Search Internet section of Sherlock provides the ability to quickly search the Internet using your choice
of popular search engines. Additional Internet search sites can be easily added by dropping their files onto
the System Folder. Search site files go into the Internet Search Sites folder. Apple does not provide
customer assistance for creating Internet Search Site files.

Find by Content and Search Internet requires QuickTime 3. The Search Internet feature is the fastest and
easiest way to search Internet search engines since you search multiple sites with a single search. This can
save time when looking for information contained in multiple locations.

To perform an Internet search, type the keywords for the information you want in the Words field. Select
the checkbox for each Internet search engine to use for the search, then click the Search button. For
example, typing "PowerBook 1400 and memory" would perform a search on the selected Internet search
sites for these keywords. The results of the search are presented in a window, ranked by relevance:

Save Search Criteria
After you have specified the search criteria for Find File, Find by Content, or Search Internet, you can save
search as a file. This file can be opened later to perform the search automatically.

Sherlock Preferences

The Preferences allows you specify options to be used with the Sherlock application. The access the
Preferences, select Preferences from the Edit menu.

Show current search status for Find File
Selecting this option provides the search status in the Find File window:
Indexing options

Select Don't index items with this label to have the index ignore all folders and files using that label.
(NOTE: Be certain that all items you wish to have indexed on the hard disk are set to use a label other than

the one you select.)
System Responsiveness while indexing

If you choose to work with the computer while indexing files, you may find the system performance to be
slow. In this case, adjust to the More Responsive setting to help improve system performance.
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Finder 8.5 CERRAGRRMR
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¢ and much more

Resizable and reorderable list views
List views for each window are resizable. To resize a list column, place the mouse pointer in between the
column headings until it changes to the resize cursor, then click and drag the column to the desired size.

List view column headings can be reordered for each window. To reorder the column headings, click and
drag the column heading to the left or right of another heading, then release the mouse button (NOTE: The

name column cannot be reordered).
New option in the Appearance control panel for "smart scrolling” adds proportional scroll boxes and
double scroll arrows.

Finder Preferences
The Finder Preferences panel, located in the Finder's Edit Menu, consolidates many global Finder settings
into a single interface. To access each group of settings, click its tab in the window.

General
Provides settings for enabling Simple Finder menus and commands, spring-loaded folders, and grid spacing.

Views
Provides global settings for each window view type (List, Icons, and Buttons).

Labels
Allows you to specify the color and name of each label that can be assigned to files and folders.

Title bar icons

The window title bar now includes the folder icon next to its name. This icon can be used just as any folder
icon can be used, without having to first switch to an icon view setting. For example, to create an alias of a
folder, click on the folder icon and drag it to the desktop while pressing the Option and Command keys:

You can also copy folders between volumes, duplicate folders, and move folders between folders by using
the title bar icon. The title bar icon can also be useful for quickly identifying the folder you are working

with.
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Badged Icons

File icons including applications, disks, and folders now change appearance when you alter the files in
certain ways. The list below shows the new icons and the type of files they indicate:

L
% 2 locked file
3

a shared folder
3 folder with an AppleScript script attached

an alias that points to another item

g

Fix Broken Aliases
A new feature in Mac OS 8.5 lets you locate the file when an alias to it can no longer find the file. When
opening an alias to a file that cannot be located, a message now appears with options:
*OK will dismiss the message and leave the alias file as is.
*Delete Alias button will move the alias file to the Trash.

+Fix Alias button opens a dialog box which allows you to locate the file and select it for use by the alias file.
An alternate method to repair a broken alias is to select Get Info from the File menu and choose "Select
New Original" from the General Information pane (see enhanced Get Info windows below).

Automatic Disk Directory Repair

When the computer crashes or is shut down improperly, data corruption or disk directory errors may occur.
The General Controls control panel option to warn when an improper shutdown has occurred now will test
and repair startup volume disk directory automatically on restart from a crash or improper shutdown. To
enable this feature, select the checkbox "Warn me if computer was shut down improperly" in the General
Controls control panel.

On startup after a crash or improper shutdown, a message appears indicating that the startup disk is being
checked by Disk First Aid. A progress bar will show the status of the disk directory repair, and when
finished, display the results.

Automatic disk directory repair only repairs the startup volume. Additional disk volumes are not tested and
repaired automatically. To test and/or repair these volumes, use the Disk First Aid utility located in the
Utilities folder.

Enhanced Get Info Windows

The Get Info option in the File menu now combines sharing and general information regarding the file,
folder, or volume you are viewing as well as the ability to select a label.

To view file size, kind, created and modified dates, comments, and label, select General Information from
the Show pull down menu.

When viewing General information on an Application, the Show menu provides a Memory selection that
allows you to adjust the application's memory settings.

To view details on file sharing settings, select Sharing from the Show pull-down menu:
Expanded Contextual Menus

The Finder's contextual menus have been expanded to include additional options:

Help - Selecting Help opens the Mac OS Help viewer with information on using volumes and files. For
more details, see the Install & Use, Part 6 - Apple Help section.

Open - Opens the selected icon.
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Get Info - This feature has been expanded to access each of the Get Info sections: General Information,
Memory (if applicable), and Sharing (see the Enhanced Get Info section above for more details).

Label - Allows you to assign a label to the icon.

Make Alias - Creates an alias file to the selected icon.

Put Away - Puts the selected volume away (applies only to mounted server volumes, removable disks, and
non-startup volumes).

Add To Favorites - Creates an alias to the selected icon in the Favorites folder. For more details, see the
Favorites section.

Find Similar Files - Searches volumes for files similar to the selected icon (only available on volumes that
have been indexed. See the Install & Use, Part 5 - Find By Content section for more details).

Attach a Folder Action - allows you to assign a Folder Action AppleScript to a folder that will be executed
each time an event occurs, such as opening the folder or adding files. For more details on Folder Actions,
see the Install & Use, Part 7 - AppleScript 1.3 section of this training.

Internet Location Files

You can create files that point to locations on the Internet or on local area networks. For example, you can
create a file that points to a web site, an AppleShare server, or an e-mail address. When you open an
Internet location file, your selected networking application will connect to the location automatically:

To create an Internet location file, highlight and drag the text containing an Internet address (such as
http://www.apple.com) into a Finder window or onto the Desktop:
After creating an Internet location file, add it to the Favorites folder for quick access in the Apple Menu.

Favorites Folder
The Favorites folder in the Apple Menu gives you convenient access to the documents, applications, zones,
servers, volumes, and Internet locations you use most frequently:
Favorite items are also available in the Network Browser (see Install & Use, Part 6 - Network Browser) and
the new Open, Save, and Choose dialog boxes.
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——— Notes

Internet Control Panel 1.0

The new Internet control panel lets you enter Internet preferences, such as your e-mail address, your default
news server, the address of your default home page, and your default Web browser, in one central location
that can be accessed by all your Internet-based applications. The Internet control panel also lets you create
groups of Internet settings that can be quickly switched.

Settings in the Internet Control Panel are only functional for third-party applications that are designed to
support Internet Config. Changing information in the Internet Control Panel may change similar information
in one or more applications. Not all applications will use all of the information settings. See the
documentation for each application for details.

There are five sections of settings within a set: Personal, E-mail, Web, News, and Advanced.

Personal - The personal section is where you enter information about yourself that will be used by Internet
applications to identify you to other users.

E-mail - The E-mail section is where user name, password, mail servers and some common e-mail
application settings are entered. All information except the application settings must come from the Internet
Service Provider (ISP) or network administrator.

Web - The Web section is where you enter some common web browser settings.

News - The News section is where you enter information used to access a news server. This information is
used by your news reader application to retrieve news groups and postings.

Advanced - The Advanced section allows you to enter more advanced settings. To access the Advanced
settings, select User Mode from the Edit menu, then selected the Advanced setting. The Advanced section
tab appears.

The Advanced section contains settings for File Transfer (FTP), Helper Apps, Fonts, File Mapping,
Firewalls, Messages, and Hosts.
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—— Notes

Apple Help

Apple Help is a new on-screen help system that lets you search for and display information about Mac OS
and its associated technologies like AppleScript. Apple Help includes the Help Viewer application which
reads HTML-based help files, connects to other help sites on the Internet, and provides links that
automatically open files and perform tasks. Apple Help can be enhanced with custom help files and, since
it's searchable and its files are stored on the hard disk, it's the fastest and easiest way to locate information
about Mac OS.

Apple Help requires QuickTime 3 software installed

You can quickly access Apple Help for specific topic by using an item's contextual menu. To do this, hold
down the Control key while clicking on the item, and select Help from the contextual menu that appears.
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Notes

Using the Installer

A standard installation on Mac OS Extended Format volumes will take up to 160 MB. A standard
installation on Mac OS Standard Format volumes will take up to 250+ MB (4 GB disk).

Hard disk space required is an estimation. You should have some extra space available during the
installation or some packages may not get installed. You can read the installer log file to find out if an

installation was successful.

Step 1: Select a Destination Disk

In this step you select where you want to install Mac OS 8.5. The installer automatically selects the most
appropriate destination disk. In most cases, this is the internal hard disk. If you want to install Mac OS 8.5
onto a volume other than your internal hard disk, select the volume using the Destination Disk pop-up
menu.

A message 1s displayed if you don't have enough space available for a standard installation. Depending on
the options you choose later, you may need as much as 250 MB of space available.The Clean Installation
option has moved from the main window to the options button. Also, pressing the Command-Shift-K keys
no longer works to access the Clean Installation option.

Step 2: Read Important Information

The next section of the installer provides late-breaking information about installing Mac OS 8.5, including
precautions, issues, and compatibility details. You can save the Installing Mac OS 8.5 file to your hard disk

by clicking the Save button.

Step 3: Software License Agreement

The next section displays the Software License Agreement which describes the conditions under which you
can use the software.
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Step 4: Install Software

The Install Software window appears. Click the Options button to view the Installation options:

Update Apple Hard Disk Drivers - No changes from Mac OS 8.1.

As mentioned earlier, if there are non-Apple hard disk drivers installed (for example, drivers from FWB
Hard Disk Toolkit, La Cie SilverLining, APS Power Tools, etc.), you will need to contact those companies
to see if updated Mac OS 8.5 compatible drivers are needed.

Apple drives that have been reformatted with third-party drivers can be reformatted with Apple drivers by
using Drive Setup.

Also, as with any major software installation, you should ensure that you have made a backup copy of the
applications and documents on the computer before installing system software.

Create Installation Report - Selecting this option (enabled by default) will generate a text file that records
the date and time of installation, the location of files added, removed, and replaced during the installation,
the results of the directory check and driver updates, and whether the installation was successful. This file
will be saved in a folder on the hard disk called Installer Logs.

The Installation Report is the best way to find out if a problem occurred during installation.Once you have
selected your choices, click the OK button.

Click the Customize button to view the Custom Installation and Removal options:

The Custom Installation and Removal section allows you to choose additional software to be installed and to
specify individual software components to be installed or removed.

After specifying all of the software installation options, you may want to save the installation settings for
future use. This can be useful in those situations where you want to install the same sets of software onto
multiple computers. When you are ready to begin installing the software, click the Start button in the
Installer window.

When the installation is complete, restart the computer. To validate successful installation, select "About
This Computer" from the Apple menu. You should get a dialog box indicating "Mac OS 8.5":

NOTE: Built-in memory, Virtual Memory, Largest Unused Block, and Mac OS memory size will vary
depending on the amount of RAM installed, the software installed, and which software is currently active.
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Navigation Services 1.1
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Navigation Services 1.1

Mac OS 8.5 offers a new Navigation Services capability to the Finder and applications updated to use these
services. These services provide enhanced open and save dialog boxes that give you more options when

opening and saving documents.

The Navigation Service file dialogs are NOT automatically used in all applications. Applications must be
first rewritten to use the Navigation Services. Customers desiring Navigation Services in a third-party
application should contact its developer to request this feature.

Mac OS 8.5 makes use of Navigation Services in the Network Browser, the Appearance and File Exchange
control panels, and to fix broken aliases.

Open several files at once by holding down the Shift key as you select files. You can also select multiple
files by holding down the Command key as you click. Note that some applications may allow you to select

only one file at a time.

Drag and drop items into the dialog box. For example, in the Desktop Pictures open/save dialog box,
dragging a folder to the dialog box will make that folder's contents appear in the dialog window.
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Network Browser 1.0
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— Notes

Network Browser

The new Network Browser lets you easily find and connect to AppleShare servers on an AppleTalk
network. You can also use the Network Browser to create a list of favorite servers and quickly connect to

these servers.

The Network Browser window has five buttons at the top part of the window: Shortcuts, Favorites, Recent,
Previous, and Next:

Shortcuts - Connect to your AppleTalk network or to an AppleShare IP file server.

Favorites - Add the names of zones, servers, and volumes that you use frequently to a list of favorite items
using the Favorites button.

Recent - Choose from a list of AppleShare volumes you have recently visited.
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Memory Control Panel
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Notes

Memory control panel

The Memory control panel has been updated for automatic disk cache calculation and the ability to disable
the startup memory tests.

Disk Cache

In the default setting, disk cache memory is calculated automatically when the computer starts up to provide
optimum application performance. The Disk Cache size changes depending on the amount of RAM installed

in the computer and allocated to a RAM disk, if any.

You can use a customn disk cache setting when your computer task requires a finely tuned Disk Cache
setting.

Raising the disk cache setting above the optimum level may decrease system performance. In most cases,
this setting will not need to be changed and should only be changed when specific recommendations have
been given by the software or hardware product developer. Apple does not have specific recommendations
about custom settings.

After entering the custom Disk Cache settings, you will need to restart the computer for the new settings to
take effect.

Startup Memory Tests

In cases where there is a significant delay in starting up the computer, disabling the startup memory tests
may help.

NOTE: This option is normally hidden until you press and hold the Command and Option keys while
opening the Memory control panel. The startup memory tests are designed to ensure that the memory is
fully functional in the computer. You should disable the startup memory tests only if you are experiencing a
long delay in starting up the computer
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ACSE Update 1999/Mac OS

MacOS 8.5.1 Update

* Drive Setup 1.6.2

* fixes

— Leak in AppleScript
- Asynchronous File 1/0

— Third party ADB

~ Sherlock proxy limitations

¢ OpenTransport 2.0.2

—— Notes

Apple recommends everyone using Mac OS 8.5 install this update. You must use the same
localized version as your Mac OS 8.5.

Drive Setup 1.6.2

Previous versions of Drive Setup can overwrite small portions of the Mac OS Standard format partition if
the partitions on the target drive are not as expected. This is an extremely rare occurrence, but could cause
drive repair utilities to report that block 0 of that volume is bad or cause the drive not to show up on the
desktop.

Volumes initialized or updated with previous versions of Drive Setup also may not always have the needed
patches installed on the hard drive. These patches are now installed on all drives. More information about
the use of Drive Setup 1.6.2 is available here.

AppleScript memory leak
Under certain conditions AppleScript 1.3.2 had a memory leak that would commonly occur when using
AppleScript.

Asynchronous File I/0
Making a large number of asynchronous writes to a Mac OS Standard or Extended format volume would
cause a memory error which could require a restart. Customers running FileMaker Pro 3.0 and later, or
FileMaker Server 2.0 and later, may experience this problem when importing large numbers of records from
an existing database.

Third party ADB
device failures A change made in Mac OS 8.5 disabled many third party dongles and joysticks.

OpenTransport 2.0.2
Based upon machine configurations, in rare instances the Mac OS 8.5 CD might have problems booting on
some systems due to a bug in OpenTransport,

Sherlock proxy limitations

Sherlock would fail to communicate through some Internet proxy firewalls and prevent customers from

: ing Sherlock to search the I L.
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ACSE Update 1999/Mac OS

Support items 8.5 - 1

* Some programs need more memory

* Some programs need Chicago as menu font

Setup Proxy server in Internet Control panel needed
for Sherlock

Error When Installing Onto PowerBook 1400 From CD

&

—— Notes

Need for more memory

If a program will not open, select the program's icon, choose Get Info from the File menu and increase its
minimum memory allocation by 300K. See the Memory topic in Mac OS Help for more information.

Chicago
A small number of application programs will not open if the system font is not set to Chicago.
Use the Appearance control panel and change the large system font to Chicago then open the program
again. Contact the manufacturer of the program to see if an updated version is available.

Sherlock

Sherlock will correctly use an HTTP proxy server if you have defined a "Web Proxy" server using the
Internet Control Panel. Sherlock version 2.0 (as supplied with Mac OS 8.5) does have a limitation that may
prevent it from working with some HTTP proxy servers.

When an Internet search is activated Sherlock correctly sends an HTTP 1.1 style request to the proxy server.

Unfortunately, the HTTP 1.1 "Host" header field is incorrectly filled in with the name of the proxy server
instead of the hostname of the resource being requested. This can cause some newer HTTP 1.1 compliant
proxy servers to drop the request and hence cause the search to fail.

Note that Mac OS 8.5.1 resolves this issue.

PowerBook 1400 error message
Problems were encountered reading the source file "Register Stuffit Expander 4.5". Installation cannot
continue.
This particular CD may encounter difficulty during installation when used with a PowerBook 1400. It
occurs when the Installer attempts to install the Internet Access component of Mac OS 8.5.1. To resolve the
situation, let the Installer finish all other installations and then custom install the components of Internet
Access separately. The Internet Utilities component of Internet Access must be installed by itself otherwise
the error will continue to occur.
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— Notes

ACSE Update 1999/Mac OS

Support items 8.5 - 2

Monitor Resolution changes after installing

Disk Tools disk

Sherlock and invisible files
— Never trash your desktop database anymore

8.5 can downgrade your hard disk driver

_.

Monitor resolution
After performing a clean install of Mac OS 8.5, your monitor resolution may have changed from its
previous settings.

Disk Tools disk
A Disk Tools disk is a floppy disk with a minimal system folder, Disk First Aid and Drive Setup. If your
hard drive and CD drive aren't working, you can start up your computer with this disk to troubleshoot
further. Also, some third-party disk-repair utilities or virus-protection programs may ask you to modify a
copy of your disk tools disk to use their software.
No physical Disk Tools diskette is included with Mac OS 8.5, if you need one however, you can make one
from the image included with Mac OS 8.5. To make a disk tools disk, double-click on the "Make Disk Tools
floppies" DiskScript. It will walk you through making a Disk Tools disk from a blank, high-density floppy
disk:
The Disk Tools floppy you make can serve as an emergency startup and utility disk, should you be unable to
start up from the Mac OS 8.5 CD. The Disk Tools disk contains Drive Setup and Disk First Aid to aid you
in your troubleshooting and disk formatting needs.
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Invisible files

Under Mac OS 8.1, when an invisible desktop database item, is dragged to the trash, the warning dialog
says "You must restart your Macintosh and immediately empty the trash.” Trying to drag any other invisible
file somewhere will produce the message "Invisible Files cannot be moved."

Under Mac OS 8.5, the Sherlock application disables drags when invisible items are displayed, since they
cannot be moved. When the menu item "Move to Trash" is selected, the warning dialog says "Invisible
items cannot be left in the trash. Do you want to delete them immediately?"

The messages and actions are somewhat different between Mac OS 8.1 and Mac OS 8.5, but the behavior is
still appropriate and also improved, in that a restart is no longer required. Since the files are being deleted
immediately, open files cannot be removed in this fashion.

Desktop database files, being always open on every mounted volume, cannot be deleted. These files do not
need to be deleted entirely and probably should not be, now that Get Info comments are being stored in the
desktop database. The process of rebuilding the database files at Finder startup time, is the proper way to
manipulate these files. The drastic procedure of making them visible and moving them to the trash now has
the potential of causing user data loss (Get Info comments). Thus these files should never be deleted directly
anymore.

The new Sherlock application can delete invisible "icon" files of a custom folder icon and the "AppleShare
PDS" file, when file sharing / AppleShare is not active.

8.5 can downgrade your hard disk driver

By default, the Mac OS 8.5 installer will "Update Apple Hard Disk Drivers”. Since Mac OS 8.5 was
released before the Mac OS 8.5.1 Update and Drive Setup 1.6.2, the Mac OS 8.5 installer will downgrade
the hard disk drivers to older versions. To avoid this issue, users should do either of the following:

oIf updated drivers have already been installed using Drive Setup 1.6.2, users should uncheck the "Update
Apple Hard Disk Drivers" option in the Mac OS 8.5 installer before reinstalling or custom installing
software. This option is found by clicking on the "Options..." button in the installer window.

«If the drivers are accidentally downgraded via the Mac OS 8.5 installer, just run the Drive Setup 1.6.2
application again to update the hard disk drivers to the latest version.

NOTE: You can tell which version of the hard disk driver you have by selecting your hard disk volume in
the Finder and choosing "Get Info" from the File menu to bring up the Get Info window. The information
next to "Where" will usually give you the driver version you are using. For example,

*Where: My Hard Disk, (ATA Bus 0 Dev 0, v3.14)

or
sWhere: My Hard Disk, Bus 1, SCSIID 0 (v8.1.0)
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